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 TC  Glossary \l 1 Glossary
· Basic Time Interval
· Target Time to Answer Calls
· Number of Agents
· Average Handling Time
· Call Volume
· Caller's Average Patience
· Number of Trunks
· Overflow Time
· Agent's Occupancy
· Agent's Availability
· Trunk Utilization
· %Answer
· %Abandon
· %Block
· %Overflow
· Average Speed of Answer
· Average Time in Queue
· %Answer within Target
· %Abandon within Target
· Average Queue Length
 
Basic Time Interval
Most ACD reports display data which is grouped according to some fixed time interval. This time interval is your "Basic Interval". 4CallCenters v2.01 supports intervals of 15, 30 and 60 minutes. Note that changing the "Basic Interval" affects the Call Volume.
See also: Settings Overview: "Basic Interval"
 
Target Time to Answer Calls
Many call centers set a target time for answering calls.This "Target" is the basis for performance indicators such as the fraction of calls answered within the target time.
See also: Settings Overview : "Target"
 
Number of Agents
The number of agents answering calls during a given interval. Include only agents which are "dedicated" to answering calls (sometimes referred to as "Full Time Equivalent" - FTE). Do not include agents having a break or performing other duties. This parameter does not necessarily remain constant during an interval. If the variations are small, use the average value, but in the case of large variations try working with a shorter time interval. 
 
Average Handling Time
The average time it takes an agent to handle a call, including wrap-up time. Although this parameter varies from agent to agent, you should take an averaged value, based on your ACD reports.
 
Call Volume
The number of inbound calls at your call center during an interval. Note that this parameter depends on the interval's length - when changing the interval's setting be sure that the corresponding call volume entered is correct.
 
Caller's Average Patience
The average time a caller is willing to wait for an answer, assuming it is subject to a very long wait. Note that the average waiting time of abandoned callers is not equivalent to the caller's average patience - it does not includes the patience of callers that were answered, those whose patience was longer than their waiting time. It includes only the callers whose patience was shorter than their required waiting time (and therefore they abandoned).
See also: Feature Overview : "Abandons"
 
Number of Trunks
The number of inbound phone lines at your call center. This determines the maximum number of calls which can be in the system simultaneously - waiting in queue, being handled by one of the agents, leaving a message in a voice box, etc. Any additional calls trying to reach the call center at such a time receive a busy signal and are said to have been "blocked".
See also: Feature Overview : "Trunks"
 
Overflow Time  
The maximum time a call can wait in queue before being overflowed to another queue, call center, voice box, IVR etc.
See also: Feature Overview : "Overflows"
 
Agent's Occupancy
The fraction of time agents are busy answering calls (or performing wrap-up activities). Note that this fraction is out of the time during which agents are totally "dedicated" to answering calls, not including breaks or other activities. Together with the "Agent's Availability" sums up to 100%.
 
Agent's Availability
The fraction of time agents are idle and therefore available to answer inbound calls. Note that this fraction is out of the time during which agents are totally "dedicated" to answering calls, not including breaks or other activities. Together with the "Agent's Occupancy" sums up to 100%.
 
Trunk Utilization
The average number of trunks utilized (by calls being handled or waiting in queue). This is equal to the "Average Queue Length" + the average number of calls being handled by your agents.
 
%Answer
The fraction of all inbound calls (including "blocked" calls) answered by your agents.
 
%Abandon
The fraction of all inbound calls (including "blocked" calls) that abandoned (hung-up) before being answered or overflowed.
 
%Block
The fraction of all inbound calls that were blocked due to full capacity - all available trunks were busy.
 
%Overflow
The fraction of all inbound calls the were overflowed from the queue before being answered or abandoning.
 
Average Speed of Answer
The average time calls wait to be answered (frequently referred to as the "ASA"). This includes calls that were answered immediately (with a wait of 0) and calls that were answered after waiting in queue.
 
Average Time in Queue
The average time calls spent waiting in queue. This includes calls that were answered immediately (with a wait of 0), abandoned calls and calls that were overflowed (with a wait equal to the overflow time). Does not include blocked calls. If there are no abandons and overflows this equals the Average Speed of Answer.
 
%Answer within Target
The fraction of all inbound calls (including "blocked") that were answered before the target time. If you set the target to 00:00, then this equals the fraction of calls receiving an immediate answer.
 
%Abandon within Target
The fraction of all inbound calls (including "blocked") that abandoned (hung-up) before the target time.
 
Average Queue Length
The average number of calls waiting in queue simultaneously. Does not include the calls being handled by agents.
Tool Overview : "Performance Profiler"

What do I do with the "Performance Profiler" tool?
Anticipating your call center's performance is essential for long and short term decision making. With this tool you can profile the performance using a wide variety of performance indicators.


How do I use the "Performance Profiler" tool?
First enter your call center's parameters. These include the number of agents answering calls during the given interval; the average time it takes to handle a call including wrap-up time; the expected call volume during the given interval; and additional parameters depending on the Features you have enabled. When you have finished filling in the parameters press "Compute", and the performance profile will promptly appear in the "Results" row, overwriting any previous results.

How do I keep my "Results"?
If you are interested in keeping your results press the "Add to Table" button, and they will be copied into the next available row in your Table.

Some more ... 
· It's a good idea to start out by checking the settings of the general parameters - the Basic Interval and Target time for answering calls. These parameters can be set via the "Settings" menu or by pressing "Change Settings". Selecting the active Performance Indicators is also done through the "Settings" dialog. For more help on these subjects consult the "Settings" overviews.
· The columns comprising the "Results" row (and the grid in general) consist of three sections: settings, input parameters and performance indicators. For a description of the various performance indicators you should advise the Glossary.
 

 

 

Tool Overview : "Staffing Query"

What do I do with the "Staffing Query" tool?
This tool is used to determine the staffing level required during a given interval in order to meet your call center's performance goal. If you have more than one performance goal to be met, you should use the "Advanced Queries" tool.

How do I use the "Staffing Query" tool?
Start by entering your call center's parameters, the first one being your call center's performance goal. In addition you must enter the average time to handle a call including wrap-up time; the expected call volume during the given interval; and additional parameters depending on the Features you have enabled. Note that the list of indicators to be chosen from for defining you goal changes according to the Features and settings you have selected. Indicators listed in parenthesis are currently "inactive" - if you select such an indicator to define your goal, it will automatically become "active" after the query is run.
When you have finished filling in the parameters press "Compute". The results will appear in the "Lower" and "Upper" result rows. 

Why are there two result rows?
The results include the number of agents required (in the "Number of Agents" column) together with the other parameters and resulting performance indicators (for a description of the various performance indicators you should advise the Glossary). The Lower and Upper staffing levels are those for which the performance achieved is closest to your required goal. 

How do I keep my results?
If you are interested in keeping your results press the "Add to Table" button in the right-hand toolbar. Both rows (Lower and Upper) will be copied to the next available rows in your Table.
 

Tool Overview : "Advanced Profiler"

What do I do with the "Advanced Profiler" tool?
The "Advanced Profiler" is an enhanced profiling tool, allowing you to enter multiple-value input parameters. Then for each combination of input parameters it produces a performance profile. This is especially useful for creating large performance tables or for preparing graphs.

How do I use the "Advanced Profiler" tool?
Here the input parameters and performance goals are entered directly into the grid using the two topmost rows ("Input" and "Multi-Value"). To enter multiple-values for an input parameter check the appropriate column of the "Multi-Value" row. This produces the "Multi-Value Input" dialog offering three formats for entering multiple-values:  "Range", "Sensitivity" and "List". Re-clicking the "Multi-Value" row of a multiple-value parameter will un-check it, restoring the parameter to be "single" valued. To edit a multiple-value entry click the appropriate column in the "Input" row.
When you are finished filling in all the Input parameters press "Compute". 

How do I keep my results?
You can keep the results by moving them into your Table using the "Add to Table" button. 
Tool Overview : "Advanced Queries"

What do I do with the "Advanced Queries" tool?
If you have multiple performance goals or if you want to determine the value of one of your input parameters, for which your goal (or goals) is achieved, you should use the "Advanced Queries". Moreover, similar to the "Advanced Profiler" tool,  this tool offers "Multi-Value Input" (for both input parameters and goals). Note that the query performed in the "Staffing Query" tool is a specific case of the above in which the input parameter being queried is the number of agents, and a single performance goal is set.

How do I use the "Advanced Queries" tool?
Here the input parameters and performance goals are entered directly into the grid using the four topmost rows ("Goals", "Query", "Input" and "Multi-Value"). To set one of your call center's performance goals click on the appropriate column in the "Goals" row and then enter its value in the "Input" row. Repeat this procedure until all goals have been entered. If you want to remove a goal simply re-click its row in the "Goals" row. 
You select the input parameter being queried by clicking on the appropriate column in the "Query" row. Selecting input parameters is mutually exclusive - selecting a second parameter will automatically un-select the previous one (re-clicking a selected parameter will also un-select it). Enter the values of all other input parameters via the "Input" row.
To enter multiple-values for a goal or input parameter, check the appropriate column of the "Multi-Value" row. This produces the "Multi-Value Input" dialog offering three formats for entering multiple-values: "Range", "Sensitivity" and "List".
When you are finished filling in the Input parameters and the performance goals, and having selected the queried parameter press "Compute". 

Why are there multiple result rows?
Depending on your "Query Output" settings, and similar to the "Staffing Query" tool, there may be "Lower" and "Upper" results. In some rare cases (when there are multiple goals) you may encounter Lower and Upper values of the queried parameter which are not consecutive. The interpretation of the results in such a case is that all values of the queried parameter in the range between the Lower and Upper values achieve the goals. Note that when your call center has multiple goals it is usually impossible to meet all goal values simultaneously, therefore achieving the goals is in the sense that the values of the performance indicators set as goals is at least (or no more than, depending on the indicator) the value set as their goal.

In some special cases you may get results in four rows : "Lower1", "Upper1", "Lower2" and "Upper2". As explained above each Lower-Upper pair is interpreted as the range of values of the queried parameter which will achieve your call center's performance goals. However, in these cases there are two separate ranges of such values.


How do I keep my results?
You can keep the results by in your Table by pressing "Add to Table". 
Tool Overview : "What-if Analysis"

What do I do with the "What-if Analysis" tool?
The main use of this powerful analysis tool is to test various what-if scenarios which arrise from the possible variations in your call center's parameters, and see the impact of such variations on your performance.


How do I use the "What-if Analysis" tool?
The input parameters are entered directly into the grid using the two topmost rows ("Vary" and "Input"). Clicking a column in the "Vary" row selects the input parameter to be varied - in each scenario it will have a different Test Value according to the variations displayed at the left side of the result rows, which are relative to the value entered in the Input row (your "basic" scenario).

Setting the number of Test Values and the percent increments is done via the "Settings" dialog (accessible either via the menu or by pressing the "Settings" button). When you have finished entering the input parameters and having checked the varied parameter, press "Compute". In the result rows you get multiple performance profiles - one for each of the scenarios.


How do I keep my results?
Press the "Add to Table" button to copy these results into your Table. 
Feature Overview : Abandons

What are "Abandons"?
Callers who hang-up due to impatience before they are answered are said to have "abandoned". An abandoned call means customer aggravation and  the loss of potential business. 

When should I enable the "Abandons" feature?
Abandons occur at most inbound call centers. Unless your call center operates with a negligible amount of abandons it is a good idea to enable the "Abandons" feature. To do this go to the setting's "Features" tab either by pressing the "Change Settings" button or via the menu bar, and check the "Abandons" feature.

What are the corresponding input parameters and performance indicators?
There is a single input parameter corresponding to the "Abandons" feature: Your callers' average patience.
Following is a list of the performance indicators available only when the "Abandons" feature is enabled: 
· %Abandon
· Average Wait in Queue
· %Abandon within Target (if a Target is used)

How can I determine the "average patience" of my callers?
Unlike other call center input parameters such as the call volume or average handling time, your callers' average patience does not appear in most standard ACD reports. Advanced queuing models used to analyze call center performance have yielded the following formula:
Average Patience (secs) = Average Wait in Queue (secs) / %Abandon
or 
Average Patience (secs) = (Average Queue Length x secs per Interval) / (%Abandon x Calls per Interval)
Alternatively, here is a possible method for determining this parameter using the "Advanced Query" tool: Go over your recent ACD reports and select a few intervals with relatively high (but not irregular) call volumes and abandons, with constant (or nearly constant) staffing levels. For each of these intervals perform an "Advanced Query" in which you "Query" the callers' average patience and enter the fraction of abandons from your reports as the "Goal". Averaging the results will give you a good estimate of your callers' average patience. (See also: Tool Overview : "Advanced Queries" )
 

 

Feature Overview : Trunks

What are "Trunks"?
Every call center has a limited number of "Trunks" (phone lines). This determines the maximum number of calls which can be in the system simultaneously - waiting in queue, being handled by one of your agents, leaving a message in a voice box, etc. Any additional calls trying to reach the call center at such a time receive a busy signal and are said to have been "blocked". A blocked call means customer aggravation and the loss of potential business.

When should I enable the "Trunks" feature?
In many call centers the number of Trunks available is large enough to practically eliminate the chance of having calls blocked with regular call volumes and staffing levels. If this is true at your call center you might choose to disable the "Trunks" feature, since enabling it won't make a significant impact on staffing or profiling results. Moreover, if the "Trunks" feature is enabled you are prevented from having the "Overflows" feature enabled as well. To enable the "Trunks" feature go to the setting's "Features" tab either by pressing the "Change Settings" button or via the menu bar, and check the "Trunks" feature.. You should keep in mind that even if your call center usually operates with negligible blocking, this might not be true in the case of unusually high workloads.

What are the corresponding input parameters and performance indicators?
The  number of "Trunks" available at your call center is the only input parameter corresponding to the "Trunks" feature.
There are two performance indicators available only when the "Trunks" feature is enabled: 
· %Block
· Average Trunks Utilized

Some more ...
Using the "Advanced Queries" and "What-if Analysis" tools you can find the optimal number of trunks at your call center and test what-if scenarios with different trunking levels.
Feature Overview : Overflows

What are "Overflows"?
At some call centers a technical limit has been set on the time a call can spend waiting in queue. Once this time limit is reached the call is "overflowed" and rerouted to some other destination, such as a different queue, an IVR or a voice box. Such an overflowing mechanism is meant to reduce congestion by offering callers a partial or temporary solution, hopefully before they become aggravated by a long wait.

When should I enable the "Overflows" feature?
If an overflowing mechanism is implemented at your call center and the fraction of calls "overflowed" is not negligible, then it is recommended that you enable the "Overflows" feature. However, since you cannot have both the "Overflows" and "Trunks" features enabled, you should decide which to enable according to the more dominant phenomena at your call center - overflowing or blocking.

What are the corresponding input parameters and performance indicators?
The input parameter corresponding to the "Overflows" feature is the "Overflow time", which is the time limit on calls waiting in queue.
There is a single performance indicator available only when the "Overflows" feature is enabled: %Overflow.
Settings Overview : "Basic Interval"

What is the "Basic Interval"?
Most ACD reports display data which is grouped according to some fixed time interval, and this is your "Basic Interval". The duration of the interval can usually be set by the ACD's administrator or sometimes as a parameter entered when requesting a report. 4CallCenters v2.01 supports intervals of 15, 30 and 60 minutes.

How do I set the "Basic Interval"?
For convenience it is best to set the "Basic Interval" to the duration of the interval used in your ACD reports. Setting the "Basic Interval" is done through the "Interval" tab of the "Settings" dialog. To access this tab either 
· Select "Interval" from the "Settings" menu.
or

· Press the "Change Settings" button and then select the "Interval" tab. 

Once you have reached the "Interval" tab select the desired value from the combo box and press "OK".
 

Settings Overview : "Target Time"

What is the "Target Time"?
Many call centers set a target time for answering calls. This "Target Time" is the basis for performance indicators such as the fraction of calls answered within the target time.

How do I set the "Target Time"?
Setting the "Target Time" is done in the "Target Time" tab of the "Settings" dialog. To access this tab either 
· Select "Target Time" from the "Settings" menu.
or 

· Press the "Change Settings" button and the select the "Target Time" tab.

Once you have reached the "Target Time" tab you can either 
· Enter your call center's target value. 
or 

· Select the no-target option. 

When you are finished press "OK".


Some more ... 
· Some Performance Indicators are not available when the no-target option has been selected.

· If you set the "Target" value to zero (i.e. 00:00) the Performance Indicator "%Answer within Target" has the interpretation of "fraction of calls answered immediately".

 

Settings Overview : "Performance Indicators"

What are the "Performance Indicators"?
There are many ways to measure the operational performance of your call center. To represent the various aspects of the operational performance you need several "Performance Indicators"

How do I set the active "Indicators"?
Setting the active "Performance Indicators" is done via the "Indicators" tab of the "Settings" dialog. To access this tab select "Indicators" from the "Settings" menu, or press the "Change Settings" button. Displayed is a list of currently available Performance Indicators (this list changes according to the enabled Features and your Target setting). Active Performance Indicators are "checked". "Clicking" on a Performance Indicator selects/unselects it. When you are finished press "OK".

Some more ... 
· You must always have at least one active Performance Indicator.
· All of the available Performance Indicators are computed, but only the active ones are displayed. Therefore if you change the active Performance Indicators you will automatically see the values of newly activated indicators without having to re-compute them.
· Regarding the Agent's Occupancy / Availability : These indicators always sum up to 100%, offering two alternatives for viewing your agents utilization. There is however an important difference relevant when using the "Advanced Queries" tool - when used as "Goals", they are both treated as "worst case" goals. That is, the "Advanced Queries" tool will try and find the values of the "queried" parameter for which an occupancy / availability of at least X% is achieved (X being your goal).
            
 

Settings Overview : "Query Output"

What is the "Query Output"?
The "Advanced Queries Tool" finds the value of an Input Parameter for which your call center's performance goals are met. The output of such a query is usually a pair of values - those for which the performance achieved is closest to your goals. With the "Query Output" setting you can control which of these values is actually returned as the answer to your query.

How do I set the "Query Output"?
Setting the "Query Output" is done via the "Query" tab of the "Settings" dialog. To access this tab either 
· Select "Query" from the "Settings" menu.
or 

· Press the "Change Settings" button and the select the "Query" tab.

Once you have reached the "Query" tab you can select one of the following output modes: 
· "Full" - queries will output full information including Upper and Lower values, and multiple ranges when relevant. 

· "Lower" - output will be only the "Lower" (i.e. smaller) value.

· "Upper" - output will be only the "Upper" (i.e. greater) value.

· "Best" - only a single value is output, the one for which the performance is closest to your call center's goals. 

When you are finished press "OK".


Some more ... 
If you run queries with multiple-value parameters or plan to create a Graph from your query results, it is best to select one of the "single value" output modes ("Lower", "Upper" or "Best"), otherwise the output tends to be confusing.

Settings Overview : "What-if"

What are the "What-if" settings?
The "What-if" settings determine the general format of the "What-if Analysis" tool. There are two parameters to be set: 
· The "number of Test Values" - the number of  "scenarios" to be tested (not including the the "basic" scenario for which you input the parameters explicitly)
· The "Test Value increments" - the change in the value of the tested parameter relative to the "basic" value you enter

How do I change the "What-if" settings?
You can change the "What-if" settings via the "What-if" tab of the "Settings" dialog. To access this tab select "What-if" from the "Settings" menu or press the "Change Settings" button. You can then change either of the two parameters (number of Test Values and Test Value increments) by selecting the desired value from the combo box. When you are finished press "OK".
            
 

Table Overview : "Basic Actions"

What are the Table's "Basic Actions"?
The Table has three basic actions:
·  Adding results to the Table.
· Deleting selected rows from the Table.
· Clearing the Table (i.e. deleting all the filled rows).
 

How do I apply "Basic Actions"?
Basic Actions can be applied either by pressing the appropriate button or via the entries under the "Table" menu in the menu-bar. Following are the details for the use of each action:
· "Adding" - when applied the current "result" rows are copied to the first available rows in the Table, adding new rows if necessary.
· "Deleting" - first you must select the rows to delete. You may not select empty rows or "result" rows. Once you have made the selection, apply the "Delete" action removes the selected rows from the Table. Note that this won't work if you select all of the rows - for this you must use the "Clear" action. 
· "Clearing" - when applied you are requested to confirm the action. Once confirmed, the Table is cleared of it's contents (not including "result" rows).
Table Overview : "Export to File"

How do I Export data to a File?
Sometimes, after accumulating results in your Table you would like to save them to a file. You can do this by pressing the "Export" button or selecting the "Export Table to File" activity from the Table menu. A standard file-saving dialog helps you enter the file name and location you want to use. When you press OK, the data from your Table will be saved in CSV format.

Table Overview : "Import from File"

How can Import help me?
If you would like your query or profile inputs be imported from an MS-Excel sheet, perhaps one that contains real data, sampled during your call center work, use the import feature. The import button or menu item works only while in the "Advanced Profiling" tab or the "Advanced Queries" tab. The idea is to import rows containing all the "inputs" that one enters before pressing the "Compute" button to make either a profile or a query. For each such row, the program will compute the desired result and add it to the table as a new row. 



How to make a successful import?
First, prepare the import file. This is usually an excel sheet containing a table similar to the one displayed by our program. The table must have a first row containing the title of the columns and additional rows containing the inputs. There should be nothing else besides that table in the sheet. 

The table must include columns for all the inputs that one is required to enter before pressing the "Compute" button. If this is the "Advanced Profiling" tab, the table must include a matching column for each yellow column (call center parameter) in the program's table. If this is the "Advanced Queries" tab, the table must include a column for each yellow column, except the column that one queries for (A column with a check mark in the "Query" row). Additionally, all the checked goal columns (white columns with check marks in the "Goals" row) must be present as well. 

The titles of the table must match exactly the titles of the program's table. You will be informed if during the import procedure, 4CC cannot find a required column. The best way to make the format of the import file right, is to export a table containing only one row first (by pressing the "Export" button) and then use this file as a template, by erasing its data (preserving the titles) and adding data just to the required columns (There is nothing wrong with having unused columns in the import file). 

The row's data must have the following format: "Time" inputs are specified in seconds and can have values between 1 and 3599. The only exception to this rule is the "Basic Interval" column which is stated in minutes and can be between 15 and 60. "Percentage" inputs must be specified as real numbers strictly bigger than 0 and smaller than 1. All "amount" inputs must be between 1 and 3999. 

When the worksheet is ready, save it in a "CSV" format (One of the available options in the Save As dialog of MS-Excel). CSV format should only be used to generate the import file. If you want to edit the sheet later in MS-Excel, save it in .xls (native MS-Excel) format as well. 

Next, while in the right tab, press the import button. A standard file-opening dialog helps you locate the justly saved import file. After pressing "Open", the table should be filled with the newly computed rows. 

You will be informed if a row contains invalid values or has one of the values missing. 

Table Overview : "Create Graph"

How do I Create a Graph?
The first step in creating a graph is filling your table with the data you want to plot. Once you have all your data ready, press the "Graph" button or select the "Create Graph" activity from the Table menu. If there is data in you table, the "Graph Settings" dialog will appear requesting the following input:
· X axis parameter - the parameter to be assigned to the X axis.
· Y axis parameter - the parameter to be assigned to the Y axis.
· Multiple-series parameter - an optional parameter (not activated when "(none)" is selected) that defines several series, that are then plotted separately on the graph. All the inputs with the same value for this parameter belong to a single series.
After defining your Graph Settings and pressing OK, an Excel workbook will open in a new window, containing the relevant data from your table and the graph you requested.
Table Overview : "Multi-Value Input"

What is "Multi-Value Input"?
The advanced tools (Profiler and Queries) allow you to enter multiple-values for input parameters and goals. This is very useful for producing large performance tables or creating graphs. Multiple-values can be entered in three formats "Range", "Sensitivity" and "List". Each and every parameter and goal (when relevant) can be multi-valued, and not necessarily of the same format. When you press "Compute" the tool performs its function for each of the parameter (and goal) combinations. Note that when multiple-values are present results are entered directly into the Table, and are not listed in the "result" rows!
 

How do I enter "Multi-Value Input"?
To enter multiple-values check the "Multi-Value" row of the desired column . This produces the "Multi-Value Input" dialog offering three formats for entering multiple-values:  "Range", "Sensitivity" and "List".
· "Range": Includes all values starting from the "Min Value" up to (and including) the "Max Value" stepping by "Step Size".
· "Sensitivity": Includes the "Base Value" and all values derived by adding or subtracting X%, where X goes from the "Increment" up to (and including) the "Range".
· "List": Includes all values entered in the list.
Re-clicking the "Multi-Value" row of a multiple-value parameter will un-check it, restoring the parameter to be "single" valued. To edit a multiple-value entry click the appropriate column in the "Input" row.
Sessions Overview : "Saving", "Loading" and "Starting a New One"

What is a session?
A session contains the following three items: 

· The table - All the computed rows in the table. 

· Settings - All the user settings (changed by pressing the "Settings" button). 

· Current inputs - All the values entered for all the inputs (eg.: The "Number of Agents Answering Calls" in the "Performance Profiler" tab, the "Performance Goal" - type and value in the "Staffing Query" tab, etc.). 

A session can be saved and then, sometime later, be reloaded. By reloading a previously saved session, the user returns to the exact state of the program that was just before the last save. 



Saving a session
Just choose "Save Session" or "Save Session As" from the "File" menu, then choose the filename (with .4cc extension) to save your session in. 



Loading a saved session
Just choose "Load Session" from the "File" menu and then choose the previously saved session file. 



Starting a new session
Choose "New Session" from the "File" menu. The program returns to its default state, with an empty table and default values for all settings and current inputs. 
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